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BEST PRACTICES COURSE – WEEK 16 – Roof Modeling & 
Documentation PART 3 - Creating Different Roof Types in ArchiCAD 
14 and Earlier 
 
Hello, this is Eric Bobrow.  In this lesson we'll take a look at ways you can create a roof shapes or types 
quickly.  This is a graphic adapted from a website.  I will put the link on the page so you can check it out 
yourself, and it shows many different roof types that are common in the U.S. and certainly are widely 
used around the world.  And I have already created these in ArchiCAD, and I will show you how I can do 
this and how you can do it very quickly, so that when you have any of these types of forms you know 
some of the best ways to get the basic shape into place.  [00:37] 
 
So we'll start out with a blank project here.  I'm working in ArchiCAD 14.  The methods that I'm using 
here are going to be typical of what is done in ArchiCAD 10 through 14; and then I'll repeat the lesson in 
ArchiCAD 16 to show how the new roof controls work.  So I will first draw a series of four walls here. And 
these will be just to create a basic box shape that's going to be 20' x 30'.  That would be about 6 or 7m x 
10m roughly. And I will select these walls and multiply them to create a grid.  So I'm going to use the 
Multiply command using the Matrix method, so I can go both horizontally and vertically on the plan. And 
I will spread them out a distance that would be appropriate.  [01:29]   
 
So 30' horizontally and 60' vertically and say OK.  This allows me to just make copies in one direction and 
then make copies in the other.  And if I scroll down a little bit I can get the fourth set.  So now you can 
see that I've very quickly gotten this shape.  So I will zoom in now on this upper area and create the first 
roof piece.  Before I do that, I will set up the roof with a convenient slope.  We're going to be doing a 
shed roof at first so its going to be a 4 and 12 slope, that if you were in a metric system, you'd be seing it 
as 18.43°.  The actual slope is not too critical, but I'm setting it up for something that is a reasonable 
shed roof.  [02:14] 
 
And I will set the base height of the pivot line for the roof to the proper height for the wall, and I'll set it 
up for visual clarity during this presentation to a paint color that will stand out nicely on our screen.  
Having done that, I will use the option for creating a rectangular roof, draw the pivot line here, tell it to 
go ,up and then draw the box around the wall.  Now I go to the Marquee tool and say show what this 
looks like. So I will go and say "Show Selection Marquee in 3D". And we're seeing something here.  I will 
go switch to an axo view so we can have it automatically fill the window with what we've got.  [02:59] 
 
So very simple shape here.  I want to make these walls come up to meet it, so I will select the four walls 
here. And I will go and make them tall enough to meet it. So I'll use the pet palette to grab this shape, 
and I will use the old fashioned method of Trim to Roof under the Design menu.  This command changes 
the shape of the wall but does not pay attention to the roof afterward. So although it looks good now, 
one of the limitations is that if I go to the roof and I change its slope using this option here to 
interactively change the slope or manually type it in to the dialog box, now the walls are not changing to 
match the roofs.  [03:44] 
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So what I'm going to do instead is undo back, take these walls here, and use the Design menu Solid 
Element Operations.  So the command is located here under the Design menu in ArchiCAD 15.  It was 
moved to the Connect submenu. In 16 it was moved a little or down in this one.  It's always going to be 
under the Design menu.  I will make these walls the target of the operation, so they are going to be 
modified. Select the roof and make it the operator, and use the command Subtraction with Upward 
Extrusion which will subtract out the volume of the roof plus everything above upward extruded from 
there. And I will execute.  [04:25] 
 
Now if I select the roof here and change the slope down, you will see how the walls trim nicely.  If I take 
the roof up higher, we'll see that the walls still retain the trim, but of course are not high enough. So in 
that case I can go perhaps select all of the walls here and just make them higher, and then they will fill 
the gap whatever they need to be.  So that is a simple way of getting that shed roof construction. Now 
I'll go ahead and make this roof back to the 4 and 12 slope that I think would be more appropriate, and 
we'll be done with that.  Now of course the roof might want to have an overhang, so I will press down 
here and use the extension of the roof.  [05:14] 
 
Now you can do this right here in 3D and sort of do it by eye, but you can't really measure the distance 
because it's not going to measure it based on what we would see on the plan.  In fact, you can see that if 
I were to snap this in line with something, it's lining it up along the roofs angle itself.  So although I can 
do this to any arbitrary size, it's actually more controlled if I go and select the roof. So let's say go to the 
Roof tool and then when I shift+click it will select the roof rather than the wall. And now when I extend 
this using the pet palette, I can just type in say the 1' distance, whatever that wants to be. And now if I 
go back to 3D, we will see that shape properly set up.  [05:59] 
 
Now I'm going to go and take that roof piece, and I will copy it over to the next batch of walls. So I will 
just use the drag command, hitting Command or Ctrl+D, and use the Command or Ctrl key to create a 
copy. So pressing down and releasing that key will make a copy.  And now, as I work with this, I'm going 
to change it into a flat roof. So the flat roof is the simplest change were going to make in today's lesson. 
And that is that all I have to do is select this roof and change its slope to zero.  So that gives me the flat 
roof shape.  Now we will go on to create a gable roof, a simple gable roof here. [06:44] 
 
And so we will go and create a roof with that as a pivot line and take this over. Now how far should it 
be? Well if it's truly a gable roof, it will go to the midpoint. Now I'm snapping here because the special 
snaps are set to halfway along the entire element. This can be very convenient so I can literally just 
create one roof piece here and then select this and mirror a copy along this edge. Now I've got the gable 
roof situation here. So I will take a look in 3D here.  Now again, if I want to have this extend, then I can 
go and extend it.  I can either go to each edge and say that I want it 1' in each of the three sides that it's 
going to be, which is certainly pretty quick.  [07:44] 
 
Now I could do that on the other one, but maybe what I will do is instead just delete the other one and 
then mirror this one. So I'll say save a step there.  Now of course I've got this shape.  Now the next one I 
do want to pick these walls up, so I will select all of the walls and activate the Wall tool;  hit Command or 
Ctrl+A, and pick them up to some height, say here, and then make them targets. And then make the 
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gable here the operator of these two roofs and execute. And in fact actually it probably would be better 
to have these at a little bit of a different angle. [08:29] 
 
So again I will just take this up to a different angle and the trim of the walls will stay intact.  Now as I 
move on to the box gable shape here, we are going to instead of actually starting over here, I will go and 
get rid of these walls and make a copy of the whole thing.  So if I say that I'd like to drag a copy here and 
I move this along say the same offset as previously done in the Multiply command, what you'll notice is 
that in the copy here, if I bring this up, it retained the actual relationship.  In other words, this wall or all 
of these walls are being trimmed by the roofs. [09:14] 
 
So when I drag a copy of the targets and the operators at the same time, it retains that information 
which is certainly a very nice thing.  Now the only thing we have to add for a box gable is another wall.  
So I will go and switch the Wall tool to do a straight piece, and I will draw another one from end to end 
of the gable.  Now this is not going to be the right height, it's down at the base. But what I can do here is 
simply select this, stretch the height up as high as it needs to be, and stretch the base up using the pet 
palette. And again, using that same pet palette of moving the top or bottom, and the go and make it the 
target and make these two roofs the operator, and execute that. [10:03] 
 
So now we have the box gable. If I want to complete this, then I might want to select this piece and 

mirror a copy across the midpoint there. And now it's going to be at both ends. So moving on then to 

the Salt Box roof. So that, if we want to just refer to that diagram here. The salt box roof is set up with 

two slopes that in this case look like they have similar slopes but one is lower down perhaps a single 

story. And one is higher up perhaps up above a second story on the back of the building or part of the 

building here. [10:43] 

So let me go ahead and create that. So we'll just zoom in on this area here, and I'll go to the Roof tool. 

And let's just take this first piece of roof here. And I don't know how far it's going to go, so I will just use 

it arbitrarily. And I will take the other piece of roof, which does start on the other side and create that 

here. Now if I look at this in 3D, we'll see something that is not going to be the salt box roof. One thing is 

I should make these a little bit steeper. So I'll go in and perhaps change these two a 6 and 12 slope or 

that would be 26.5˚. [11:35] 

But I need to make this one start higher so it would be up above the second floor. I'll just take it up to 

15' for now so that it just jumps up in space. The principle would be the same regardless of the height. 

But now what we want to do is have ArchiCAD compute where these two would meet. So I will select 

one of them, here, hold down the Command or Ctrl key, go to the edge of the other roof and click. You 

notice how it adjusted slightly. And I will select this one, and I will make it the controlling one, and then 

Command or Ctrl click on the edge of the other one. You can see how instantly makes them find their 

meeting point there. [12:15] 

So again, I will select all the walls here, I will make them taller, make them targets, select the two roofs.  

So go to the Roof tool, Command+A or Ctrl+A , make them operators, and execute.  And now we have 



 
 

  Best Practices Course – Week 16 Part 3 – © copyright 2012 by Eric Bobrow 
 

the salt box roof.  Now one thing about that image here is that the salt box roof shows the roof 

integrated with the wall so that they are not standing out.  And obviously, that would be done by 

making them the same material.  So I will select these two roofs here and we'll go in and with the 

material locked, I will just switch it to the same materials as the walls. [12:55] 

Now this looks close, but we're still seeing some lines where the roofs and walls meet.  However, this is 

because we are looking in the most common 3D view mode, which is the open GL engine.  If I switch to 

the internal 3D engine, ArchiCAD will take a little more time and it will remove the lines between 

adjacent surfaces that have the same material and are in the same plane.  So now it's exactly like what 

we had before, although the roof still is a separate element from the wall. [13:28] 

Now we'll go on to the butterfly roof. So if we zoom in here, what I'm going to do is just copy the two 
roofs that are up in this area that created the simple gable. And I will just drag a copy of this with a 
reference point there. So what that did was it dragged them in relationship to the wall so it kept the 
same overhang there.  Now we'll take a look at this and see how quickly we can create this butterfly 
effect.  So if I show this one, here is the gable.  Let me simply switch the two walls here or two roofs to 
have a negative slope. So they are going to be going down from the outside. And there you can see 
they've created the butterfly shape. I'm going to make them the operators. I will go to the Wall tool, 
Select All Walls, make them targets, and execute. And you can see how quickly we can get a butterfly 
roof.  [14:31] 
 
Now we'll move on to a gambrel roof. So in the gambrel roof, we have then two roofs with steep pitch 
and then a shallower pitch. And this is mirrored across the other side. So let's see how we create that.  
So we will go back here and we'll create the first roof piece. And this one is actually going to be a lot 
steeper.  I don't know how far in it will go, but let's just take this up to say 24 and 12, which would be 
say a 63° angle.  Now, when I'm creating the other piece here, if I look at this in 3D, I may want to figure 
out where it meets here and then go up. But in some cases, in fact in many cases, you are going to want 
to determine that based on how high the peak is.  [15:36] 
 
And so this would be another way to do it that I think is very useful to understand is that I can go and 
create, in terms of the roof, let's say a shallower roof, let's say a 4 and 12 roof, but one that is up higher.  
So if I set the pivot line here to be 20', then the peak, I can draw that as the peak and have it go down.  
Now I could set the slope to be negative, but let's just leave the slope to be positive and show another 
way that you can draw this.  I'm going to literally draw this from the center snap here as the pivot line, 
but tell it to go up to the left.  But then I'm going to actually draw the body of the roof going to the right. 
[16:17] 
 
So you see the little stub line indicating that it's sloping up this way, but I'm actually drawing it down 
there.  So this can be very good for being able to control and tilt the roof based on the ridge line in this 
case.  Now if we go to 3D, you are going to see that we've got the two pieces that will meet, but I need 
to have ArchiCAD adjust them to where they will find a meeting point.  So I will select this one here and 
then Command or Ctrl+click the edge of the other.  It will move to the edge of where it's going to meet 
and adjust the angle of it.  And I can select the second roof and Command or Ctrl+click to make them 
join.  [16:58] 
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So now I've got a good shape there.  Before I mirror this, which obviously I want to do, I want to go 
ahead and get these overhangs.  So again I will take this and just tell it to expand 1' in all directions, but 
then take this 1 edge back just the 1'. So it did the three sides in only two steps.  And I can do the same 
here or actually I can go and take just the top and bottom ones and just snap them into position.  So 
now they are cleanly overhanging a uniform amount.  And I'll take these two roofs and mirror a copy 
over there.[17:44] 
 
And if I go to 3D, we'll see we have the basic shape. Again, take the walls, Command+A or Ctrl+A, make 
them targets, make them say go up 20' or something like that. And then go Roof tool, Command+A or 
Ctrl+A make them operators, execute, and we're done.  So the next one will be an M shape roof.  So if I 
go back to that preview, the m shape roof going up and down and meeting in the middle; and mirrored 
across the center. So we will go back here and draw the roof, say put it back down to the 10' base, and 
perhaps make this a steeper 12 and 12 or 45° slope. [18:35] 
 
And take this going up like this. And in this case I'm going to do it from the center going back, but I will 
do the conventional thing where the bottom is the center and it's going up to meet the other one. Now 
again if I have this in 3D, we are going to see that this would be a certain type of an M, but in the 
illustration here you can see that it's actually a taller ridge line or a plate line in the center. So what I'll 
do is just take this it and raise it up let's say to 15', whatever distance might be appropriate, and then 
use that and Command or Ctrl click the edge of this one.  Select this one and Command or Ctrl click that. 
And you can see how they meet. [19:37] 
 
And of course I can go in and then mirror a copy. And what I like to do often is actually is just mirror a 
copy right here in 3D.  So I'm looking at it and do that mirror a copy right along this edge. So I am 
snapping right here in 3D, very satisfying.  And in this case I'm going to go and make the walls again 
targets, and the roofs operators, and execute.  And I will leave this without an overhang and perhaps do 
the same thing that I did earlier where I just made these roofs say the same material as the walls so that 
they will blend in like what the illustration was.  [20:27] 
 
So moving on, we are going to go now to the Skillion and Lean-to roof.  Here you can see this one is 
basically two shed roofs with one part of the building extended out separately. So we will go and create 
that.  That is very simple to do what I'll do is create the extra walls here and sort of do this by eye but 
type in some distances here. I will do a series of walls. And now we will create the first roof and tell it to 
overhang 1', and perhaps let's change this since it's going to be a sort of shed roof. We'll just make it a 
little bit shallower slope here. And then I will use the same settings, I will use the eyedropper to pick up 
what I just did and I'll make the other roof piece here.  [21:44] 
 
And I'll tell it to extend and again extend it on all sides and bring it back in the one side, snapping it in.  
So that's two steps instead of having to do all of them.  It's quicker, and this then - go to 3D here, and 
you can see the shape that it's done.  So very quickly just select the two roofs, to make them operators, 
select all of the different walls and make them targets; make the walls go up and execute the 
subtraction.  So that's the Skillion and Lean-to roof. Now we're going to go on to a traditional hip roof. 
So if we look at that illustration here, Hip and Valley roof, we are going to take advantage of ArchiCAD's 
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tools for creating this automatically. So I will just pull this back and extend this out and draw some extra 
walls to create a convenient shape here. [22:59] 
 
The nice thing about this is that whatever the shape is that you've got, ArchiCAD will build the roofs 

around it using the magic wand. This is done using the option within the roof geometry of a poly roof. 

Now in ArchiCAD 14 and earlier, after I do this, all of these roofs will be individual that can be edited in 

ArchiCAD 15 and later. They become a unit of roofs that can be adjusted as a whole. Anyway, I'm going 

to use the magic wand, click on this, and we're going to set this up for a single level.  It is actually 

possible to do multiple levels using the poly roof option here.  [24:05] 

We will set it up for an 8 and 12 slope with a 1' overhang and straight sides here, so this all should be 

good. And you can see how quickly that created the shape that we need.  So I zoom out here. You can 

see what that has created. Now we'll be spending time in a later lesson looking at how you can adjust 

and create these things manually, but this is something very convenient for a basic shape that you want 

to draw very quickly.  And the next one is going to be a variation of that. I'm going to go and take this 20 

x 30 box and stretch it using the Marquee tool to make it square. [24:50] 

So I've just basically told it to extend that by 10', so now it's 30 x 30. And when I do that roof object 

here, in this case, if I use the magic wand and trace it and have that one level roof, the same sort of 

thing. It's going to be just a pyramidial roof.  So if I go now and look at this one, we can see how simple 

and easy that was to create.  Now a variation of that would be on a polygon such as a hexagon or the 

hexagonal gazebo roof.  So what I'll do is create a hexagon shape here.  I'm going to do that by tracing a 

circle. So let's do a circle with a radius of 6' here. And then I will go to the Wall tool. Now if I use the 

magic wand to trace it normally, you can see how it creates a circular wall. But that's not what I want. I 

want to create a hexagonal one. [25:52] 

So I'm going to the Magic Wand Settings under the Options menu and tell it to do segments along the 

circle, six different segments. And do it linear, don't try to do curves. And so now when I use the magic 

wand on it, you will see that it's created six walls that are forming a hexagon. And then if I go to the Roof 

tool here and perhaps change the slope of this roof up a little bit, make it a little bit steeper, and then 

use the magic wand on the walls, we can see how it instantly creates a shape there. And let's take a look 

at that. And you can see we can get the hexagonal gazebo roof style very easily.  If we actually wanted 

to do something with more sides, let's just say that I do that circle and take that same distance here.  

[26:54] 

And with the Roof tool, I can use the magic wand and trace here. Actually I need to set it for this shape 

here. And now you can see here are the six sides we just did. But if I really wanted more sides I could 

change that magic wand setting and perhaps make it 12 sides or something like that.  And you can see 

how it's now created more sides and in fact if we set that up to some larger number here like 36, it will 
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start to look like it's really a cone shape. So we'll just take this and again do the roof here. And you can 

see how it's created so many of them.  [27:55] 

So if we use the marquee to be able to focus our view on the three of them, we are going to see how 

different settings of the magic wand will create different shapes. Now in later versions of ArchiCAD we 

do have the Shell tool, which would allow us to create a smooth curve that's rotated, as well as the 

Morph tool which will do some other interesting variations. But these still can be sort of segmented, can 

be a good way to model certain types of roofs.  So we will move on to create a Mansard roof.  So if we 

look at this illustration, you can see that it has the steep side and then a shallower side, sort of like the 

Gambrel, except that it's on all four sides.  [28:41] 

So now that we've actually worked with the segments of the automatic roof generation, we can actually 

adapt that here.  So what I'll do is go to the Roof tool and we'll set up for the polygon type of roof and 

tell it to trace this shape. But in this case we will tell it to have two levels. And then that allows us to set 

for example a steep slope. In this case, I will make it really steep, say 48 and 12, which would be 4 to 1, a 

very steep slope. And then the next one will be shallower, let's say 6 and 12. Now you may need to 

setup how far the steep one will go. And this is how far in its own area, essentially from bottom to top 

where it would stop there. [29:32] 

And I'm going to take this to 12 feet, and that means it will sort of stop at that point and then it will start 

the flatter roof and go as far as it needs. The 30 ' is way more than it needs. I will just leave that alone. 

And we'll say OK. And you can see when I created it, it created something that looks like a standard sort 

of hip roof, but if you look closely at it, you'll see that there's this extra roof piece here. There are 

actually an outer roof and an inner roof. And if we go to 3D, we'll see that it's created very quickly a 

Mansard shape. Now we do have one issue here and that is that the edges of the roof are going straight 

up and down. [30:13] 

And that can start to be a problem. You could use Solid Element Operations to trim off the bottom, 

creating some other element as a cutting tool, but another option that can be good, and I will just undo 

to be able to reset it, is I will go and trace this again, but I will make it have a perpendicular edge. Or I 

could make it could make it a horizontal edge underneath. One or the other could be good. Now I will 

also change the slope here. I'd like to get it a little bit flatter at the top and perhaps a little bit higher at 

the sides.  [30:49] 

So you can play around with this until you get the result you need. So now when I redo this, you will see 

that this is going in a little bit further. The shape is now a little bit more to my liking, a little bit closer to 

the illustration in the diagram.  So that would be a Mansard roof. Now another thing that you can do, 

the Mansard, if we go back to the diagram, the Mansard and the Gambrel are actually quite similar. And 

so instead of creating the Gambrel out of two separate pieces and telling them to trim, we might find 

that another way to do it would be to create the Mansard and delete the end panels.  [31:31] 



 
 

  Best Practices Course – Week 16 Part 3 – © copyright 2012 by Eric Bobrow 
 

So let's just take a look at how you would do that.  So if I go and let's say select all of the walls in this 

marquee, and then drag a copy down, say the 60', now I've got these walls. And I could go into the Roof 

tool and again trace with the same settings. But then I will just get rid of the roofs at either end here. 

And let's take a look at what we've got. You can see that this is actually similar to the Gambrel, except 

that I would just need to extend the ends. So if I go to the floor plan, there are two ways that I might do 

this. I might actually go and take each one of these roofs and press down, tell it to move this node, and 

perhaps use the Shift key or the guideline to find where this goes. [32:44] 

Let's see, if I use the guideline here and slide over it and then find that perpendicular, I could do that. 

And of course I could take this one down and perhaps use the Shift key and lock it.  So I can manually 

take these points down. Let's take this down here and repeat the process very quickly. But there's 

another way that can be even quicker for adjusting these points, and that is to use the Marquee tool 

itself.  So if I use the Marquee tool and hit the Esc to get rid of it, and then say draw with the Marquee 

tool around this corner, now I can sort of grab this point and move it up, perhaps use the Shift key and 

line it up here. [33:39] 

That will reposition both nodes, both roofs that are here. And go to the marquee and do the same thing 

up. So what happening is the marquee is enclosing two elements, in this case, two roofs, but a shared 

node. And when I move the marquee, it allows it to reposition.  Now to see the results here, I will just 

zoom out a little bit and do the marquee around this, and we'll take a look.  So that would be another 

way the you could get the Gambrel roof context. And again I'd just take all the walls that are currently in 

this view, make them targets, select all of the roofs, and make them operators and execute. Now we 

didn't see a change because the walls are too short so actually all I have to do is select the walls here 

and make them tall enough, and they will just snug up to the roofs.  [34:39] 

So you can actually create that relationship earlier, and then know that when you raise the height of the 

wall, they'll just come up into position. So now we will go on to the Combination roof here. So we'll take 

a look at what we're going to be creating here. So the combination roof is actually very similar to the 

Mansard roof, only in reverse. It's basically going to use ArchiCAD's ability to create two different roof 

planes, roof angles in a single set and we are going to have it shallow then steeper rather than the other 

way around. So we will go back in here and zoom in on the next one, and create the roof. So I'll just tell 

it to trace this here. [35:30] 

We always have to make sure that we're in the poly roof creation and then here I will change the slope. 

So I'm going to make this say 6 and 12 so it will be shallower and then 12 and 12. And then I need to tell 

it what height it's going up, so we will take this just 2 feet up. So this is basically going to go in a shallow 

angle a certain distance. And you can experiment with this until you get the right proportions, but very 

quickly get that result.  I will take this with a vertical roof fascia. Now we'll take a look at this. And you 

can see how very quickly it created that shape.  You can generalize this for a church steeple and things 

like that. This could have multiple segments that sort of gradually gets steeper. [36:22] 
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And you can have more than the two. And of course you can have it trace around in a circle if you 

wanted and create something like we had for the gazebo, except in a more upturned sort of fashion. 

Now we will go on to the - take that image here, and the one we're going to do now is the Dutch Gable 

roof.  At first glance, it looks like it's quite complex, but actually it's very similar to just a normal hip roof 

except that we are taking out a piece and extending that center point.  So let's see how that works.  

[37:03] 

I will go to the Roof tool, do this polygon one, tell it to trace here, and I will tell this to be just a single 

slope and tell it to be say 8 and 12 and again have to raise it up.  Now if I had left this low we will see 

what happens. You can see that it actually stopped the roof at a certain height. And we'll just see what 

this does.  Sometimes it can be useful of course. It went up just the distance that I specified and then 

created a flat center there.  Let me just undo it again and with the Roof tool go and trace this here.  

[37:52] 

We need to make sure that the Roof tool is set for the polygon and trace there, and we'll just make sure 

that it says go up far enough that it can reach the peak.  And now in terms of this shape which is of 

course a very simple shape that we've got, what I'm going to do is take this and I'll cut off part of it.  So it 

might be simpler to do that in the floor plan.  I'll go using the variety of ways I can do this I will perhaps 

use the split and say split off a piece and then delete that. And then if I look at it in 3D here, we'll see 

that I've just opened that up. And I can go and edit the shape.  [38:48] 

So if I go back here and select this, I can move this corner here and add another node there. 

Alternatively, I can select this and add a node before I go, and then pull this down, either way will work.  

And so now if I go to 3D we can see a shape similar to what we had.  Now in terms of this, it might 

actually be better for this to be steeper. There are certainly some variations where this would be a 

steeper shape.  So if I select this and perhaps change its slope from the 8 and 12 to 12 and 12 here, now 

if we look at it in 3D we will see that it's going up higher. So we would actually need to readjust where 

these meet.  [39:40] 

And again I'm going to take advantage of ArchiCAD's ability to control the roofs automatically.  I will 

select this roof as the controlling one and then use the Command or Ctrl key to reposition this back to 

where it will meet and do the same thing. I will deselect the other roof and go and Command or Ctrl the 

edge of this one. Now you have to make sure that you're pointing at that other roof unambiguously.  In 

other words, it's not pointing at something on the main roof but pointing at something on the other 

one.  Then it can deal with it.  [40:20] 

So at this point, we've now repositioned this, but what I want to do is actually go and then have the 

steeper roof control where the other edges are going.  So I'm selecting it and then Command or ctrl 

clicking the other one.  Now obviously this shape here has gotten too short where its meeting in a way 

that isn't appropriate.  So I'm actually going to pull this back. And I can do this sort of by eye here.  But 
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you can see how it's just maintaining the connection along the edges there.  So at this point it might be 

easiest to again, correct the shape. And what I'll do is use a final method here where I say add to the 

shape of the roof. And I'll just click on a series of points that basically enclose the new shape, and that 

then extends it.  [41:17] 

So if I select this one again, press down and use the boolean plus, and just create the shape. And then I 

will still have one extra node point that I could reposition down to simplify the shape.  Now if I want to 

get this on the other side, I can go and delete the original roof here, select this, mirror a copy across the 

center here. And now, I will show you another method.  I can go and say do this plus, again the same 

thing like that. Now it looks like there's a little bit of cleanup here that I will need to do. In fact let me 

clean this up first. So what I have to do is select this roof and tell it to control and adjust the other edges 

of the roofs. And you can see how that adjusts these roofs in turn.  [42:23] 

Now having done that, I can again go and add this shape in here and perhaps for the final one, when I do 

the add, so this little plus, I can use the magic wand and say, "Find the area in here." And you can see 

how it adds that shape.  So this allows me to more quickly deal with sometimes when I just have a little 

gap that I want to fill in.  So at this point, having done all of that work, we’ve got something that is 

almost working here. You can see the basic shape is working, but this is sticking out a bit too far.  So 

what I will need to do is just zoom in on this and say select this roof piece and pull it in to me. Because 

this a steeper it will have less of an overhang and meet there. [43:27] 

And we'll do it on the other side as well. So I brought that in. And so now if I look in 3D at this, we are 

going to see something pretty close. We do have a little bit of an issue is that the fascia of this one, 

because it's steeper, is actually looking like it sticks out a little bit.  So there is this little extra corner. So 

you'll probably have to do some type of adjustment in terms of Solid Element Operations to do some 

extra trimming. But let's leave this alone for now and say that the basic shape is exactly what we need.  

And so we have now one more that are going to be doing, and that is the Jerkinhead roof, which has 

other names. I can't remember right now what those are. But the Jerkinhead is basically going to be 

similar to the Gable, just with a little piece where it's moved out.  [44:37] 

So it's actually quite simple to make here. So we'll go and do that.  So I will go and use the Roof tool and 

we'll tell it to use the magic wand again for this. And take this with say the 8 and 12 slope, just a single 

level like that. Then take a look in 3D, and what we want to do is just have a little piece of this roof stick 

out further. So the simplest thing that I found is to select this and say trim it off.  So I can go and split off 

a piece. Now I could measure this precisely, but I will just sort of do it by eye.  And actually I trimmed off 

the wrong part. I want to trim off the bottom part. And so now we have this little piece of roof which I 

am going to drag down. Let's say drag this down so that it meets this edge and I will get rid of the bigger 

piece of the roof.  [46:00] 
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So now I've cut the roof in two pieces and took one part of it out.  We look in 3D and you can see how 

it's floating out there.  So now it's just a matter of extending these pieces.  Again, I will just use the little 

plus and tell it to fill in the gap around here and do the same thing on this side.  We'll take a look in 3D.  

And you can see how very quickly we got that shape. Of course let's just take these all the walls, make 

them targets, take them up high enough and then select the roofs, make them operators, and execute. 

So that's going to be that shape there.  We do need to just repeat the operation on the other 

side.[47:00] 

So what I'll do is again I will just get rid of this piece, select this one, and mirror a copy.  Now you may 

notice that this actually has a pivot line way out there. So actually before we do that let's reconcile this.  

So the pivot line here says that its 10' at this point and then it goes up. This of course is not going to 

print and of course it is in the right elevation, but I can move the pivot line using this move sub element 

from the pet palette and put it in line with the wall just like everything else.  And when I do that, what 

we are going to see is that it now has repositioned this roof to have the same plate line as the other one.  

Of course that's not what we want, but what we can simply do is press down and tell it to move up or 

down and simply snap it into position.[47:56] 

So you can see now it has the same geometry, but the pivot line for it is still at the end there.  So it 

might be a little cleaner result or management process.  So we will mirror a copy over the center here 

and then take this and add the shape in.  We're going to take the other one. And I could just reposition 

and perhaps just add a node would be the other way to do it instead of adding the shape.  So either way 

would work, and we are just going to have one last thing which is probably that the wall is not trimming 

to this roof, because this is a new roof that was just duplicated.  So it's going to be the operator.  [48:52] 

And I will select this wall as the target and execute.  And now it's trimmed off.  So if I go back to the floor 

plan we'll see that I've created a whole bunch of little roofs. And very quickly if I say shall all of these 

roofs in 3D. So this has been Eric Bobrow.  I will repeat this lesson with version 16, showing how roofs 

are constructed in version 15 and later. Because while some of the operations will be identical, others 

will be quite different.  This has been Eric Bobrow, please add your comments and questions on the 

page down below. Thanks for watching.   

[END OF AUDIO 49:32] 


